User Manual

Affymetrix® GeneChip® Command Console® (AGCC) 4.0

Installation Instructions

For Research Use Only. Not for use in diagnostic procedures.
For research use only.
Not for use in diagnostic procedures.

Trademarks
Affymetrix®, GeneChip®, NetAffx®, Command Console®, Powered by Affymetrix™, GeneChip-compatible™, Genotyping
Console™, DMET™, GeneTitan®, Axiom®, MyDesign™, and GeneAtlas® are trademarks or registered trademarks of
Affymetrix, Inc. All other trademarks are the property of their respective owners.

Limited License Notice
Limited License. Subject to the Affymetrix terms and conditions that govern your use of Affymetrix products, Affymetrix
grants you a non-exclusive, non-transferable, non-sublicensable license to use this Affymetrix product only in accordance with
the manual and written instructions provided by Affymetrix. You understand and agree that except as expressly set forth in
the Affymetrix terms and conditions, that no right or license to any patent or other intellectual property owned or licensable
by Affymetrix is conveyed or implied by this Affymetrix product. In particular, no right or license is conveyed or implied to use
this Affymetrix product in combination with a product not provided, licensed or specifically recommended by Affymetrix for
such use.

Patents
Scanner products may be covered by one or more of the following patents: U.S. Patent Nos. 5,578,832; 5,631,734; 5,834,758;
5,936,324; 5,981,956; 6,025,601; 6,141,096; 6,171,793; 6,185,030; 6,201,639; 6,207,960; 6,218,803; 6,225,625; 6,252,236;
6,335,824; 6,403,320; 6,407,858; 6,472,671; 6,490,533; 6,550,411; 6,643,015; 6,813,567; and other U.S. or foreign patents.

Software products may be covered by one or more of the following patents: U.S. Patent Nos. 5,733,729; 5,795,716; 5,974,164;
6,066,454; 6,090,555; 6,185,561; 6,188,783; 6,223,127; 6,228,593; 6,229,911; 6,242,180; 6,308,170; 6,361,937; 6,420,108;
6,484,183; 6,505,125; 6,510,391; 6,532,462; 6,546,340; 6,687,692; 6,607,887; 7,062,092 and other U.S. or foreign patents.

Fluidics stations Products may be covered by U.S. Patent No. 6,114,122; 6,287,850; 6,391,623; 6,422,249; and other U.S. or
foreign patents.

AutoLoader products may be covered by one or more of the following patents: U.S. Patent Nos. 6,511,277; 6,604,902;
6,705,754; 7,108,472; and other U.S. or foreign patents.

Copyright
© 2013 Affymetrix, Inc. All Rights Reserved.
# Table of Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Welcome to the Installation Instructions .................................................. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conventions Used in This Guide  .......................................................... 5</td>
</tr>
<tr>
<td></td>
<td>Resources .......................................................................................... 6</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Installing AGCC 4.0 on Windows XP or Windows 7 ....................................... 8</td>
</tr>
<tr>
<td></td>
<td>Overview of Installation .............................................................................. 8</td>
</tr>
<tr>
<td></td>
<td>Installing the AGCC Components on Windows XP or Windows 7 ....................... 12</td>
</tr>
<tr>
<td></td>
<td>Installing Affymetrix Data Exchange Console ........................................... 19</td>
</tr>
<tr>
<td></td>
<td>Importing Libraries for Cartridge Arrays ............................................... 31</td>
</tr>
<tr>
<td></td>
<td>Installing GeneTitan Library Files ......................................................... 45</td>
</tr>
<tr>
<td></td>
<td>Installing Fluidics Protocols ................................................................... 47</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Upgrading to AGCC 4.0 on Windows XP or Windows 7 ....................................... 52</td>
</tr>
<tr>
<td></td>
<td>Upgrade Outline .......................................................................................... 52</td>
</tr>
<tr>
<td></td>
<td>Upgrading the AGCC Components on Windows XP or Windows 7 ....................... 52</td>
</tr>
<tr>
<td></td>
<td>Upgrading Affymetrix Data Exchange Console and Other Components ............... 57</td>
</tr>
<tr>
<td>Appendix A</td>
<td>Setup for GeneTitan IC Workstation ............................................................ 62</td>
</tr>
</tbody>
</table>
Welcome to the Installation Instructions

The AGCC Installation Instructions contain instructions for installing and configuring or upgrading the AGCC 4.0 software components on a computer running Windows XP Professional (32-bit) SP3 or Windows 7 Professional (64-bit) SP1:

- Chapter 2, Installing AGCC 4.0 on Windows XP or Windows 7 on page 8
- Chapter 3, Upgrading to AGCC 4.0 on Windows XP or Windows 7 on page 52

Conventions Used in This Guide

This guide provides detailed instructions for installing AGCC on a computer running Windows XP Pro SP3. Various conventions are used throughout the manual to help illustrate the procedures described. Explanations of these conventions are provided below.

Steps

Instructions for procedures are written in a step format. Immediately following the step number is the action to be performed. Following the response additional information pertaining to the step may be found and is presented in paragraph format. For example:

1. Click Yes to continue.
   - The Delete task proceeds.
   - In the lower right pane the status is displayed.
   - To view more information pertaining to the delete task, right-click Delete and select View Task Log from the shortcut menu that appears.

Font Styles

Bold fonts indicate names of commands, buttons, options or titles within a dialog box. When asked to enter specific information, such input appears in italics within the procedure being outlined. For example:

1. Click the Find button or select Edit → Find from the menu bar.
   - The Find dialog box appears.
2. Enter AFFX-BioB-5_at in the Find what box, then click Find Next to view the first search result.
3. Continue to click Find Next to view each successive search result.

Screen Captures

The steps outlining procedures are frequently supplemented with screen captures to further illustrate the instructions given. The screen captures depicted in this manual may not exactly match the windows displayed on your screen.

Additional Comments

[![TIP]]: Information presented in Tips provide helpful advice or shortcuts for completing a task.

[![NOTE]]: The Note format presents important information pertaining to the text or procedure being outlined.
IMPORTANT: The Important format presents important information that may affect the accuracy of your results.

CAUTION: Caution notes advise you that the consequence(s) of an action may be irreversible and/or result in lost data.

WARNING: Warnings alert you to situations where physical harm to person or damage to hardware is possible.

Resources

Online Documentation

The Zip File with AGCC software includes an electronic version of this guide. The online documentation is in Adobe Acrobat® format (a *.pdf file) and is readable with the Adobe® Acrobat Reader® software, available at no charge from Adobe at http://www.adobe.com.

Context-sensitive online help can be accessed by clicking the help links in the software components.

Technical Support

Affymetrix provides technical support to all licensed users via phone or E-mail. To contact Affymetrix® Technical Support:

Affymetrix, Inc.
3420 Central Expressway
Santa Clara, CA 95051 USA
E-mail: support@affymetrix.com
Tel: 1-888-362-2447 (1-888-DNA-CHIP)
Fax: 1-408-731-5441

Affymetrix UK Ltd.
Voyager, Mercury Park
Wycombe Lane, Wooburn Green
High Wycombe HP10 0HH
United Kingdom
UK and Others Tel: +44 (0) 1628 552550
France Tel: 0800919505
Germany Tel: 01803001334
E-mail: supporteurope@affymetrix.com
Tel: +44 (0) 1628 552550
Fax: +44 (0) 1628 552585
Affymetrix Japan, K. K.
ORIX Hamamatsucho Bldg, 7F
1-24-8 Hamamatsucho, Minato-ku
Tokyo 105-0013 Japan
Tel: +81-3-6430-4020
Fax: +81-3-6430-4021
salesjapan@affymetrix.com
supportjapan@affymetrix.com

www.affymetrix.com
Installing AGCC 4.0 on Windows XP or Windows 7

This chapter has instructions for installing the AGCC 4.0 software on a computer running Windows XP Professional (32-bit) SP3 or Windows 7 Professional (64-bit) SP1.

IMPORTANT: AGCC 4.0 supports upgrades from AGCC 3.2.4 (or higher) on Windows XP and AGCC 3.3 (or higher) on Windows 7. See Chapter 3, Upgrading to AGCC 4.0 on Windows XP or Windows 7 on page 52.

The features and functions of AGCC vary depending upon which instrument or instruments it is being used with.

Table 2.1 Operating systems for AGCC

<table>
<thead>
<tr>
<th>Operating System</th>
<th>GCS3000/FS450 Instrument</th>
<th>GeneTitan® Instrument</th>
<th>Analysis Only Workstation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP Pro (32-bit) SP3</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows 7 Pro (64-bit) SP1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

A computer running AGCC software and Windows XP or Windows 7 can also be connected to a Windows network to provide other options for organizing and consolidating data. For more information, see Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 of the AGCC User Manual.

The installation process is described in the following sections:

- Overview of Installation, below
- Installing the AGCC Components on Windows XP or Windows 7 on page 12
- Installing Affymetrix Data Exchange Console on page 19
- Importing Libraries for Cartridge Arrays on page 31
- Installing Fluidics Protocols on page 47

Overview of Installation

The installation overview contains:

- Requirements
- Installation and Configuration Outline on page 11

Requirements

There are three different options for installing AGCC; each option has different requirements:

- Installing AGCC with Instrument Control for Cartridge Arrays on page 9
  Supports:
  - Fluidics Station 450 (FS450)
  - GeneChip Scanner 3000 (GCS3000)
- Installing AGCC with AGCC GeneTitan Control on page 9
  Supports the GeneTitan Instrument
- Installing AGCC for Analysis Workstation on page 10
Installing AGCC with Instrument Control for Cartridge Arrays

The AGCC Instrument Control system for Cartridge Arrays supports:

- Fluidics Station 450 (FS450)
- GeneChip Scanner 3000 (GCS3000)

AGCC with Instrument Control for Cartridge Arrays requires the following AGCC components:

- AGCC Portal
- AGCC Fluidics Control
- AGCC Scan Control
- AGCC Viewer

NOTE: GeneTitan Library File Installer is installed with both AGCC and DEC.

AGCC with Instrument Control for Cartridge Arrays requires the following tools:

- Data Exchange Console
- Reconnector
- Library File Importer

NOTE: GeneTitan Library File Installer is installed with both AGCC and DEC.

- Email Configuration Editor
- Data Uploader

The AGCC Instrument Control System requires the following:

- Installation on Windows XP Professional (32-bit) with SP3 or Windows 7 Professional (64-bit) with SP1.

NOTE: Storage requirements depend upon how much data you wish to store on the Instrument Control system before moving the data to another computer.

- Internet Explorer 8.0 and newer or Firefox 2.0 and newer

Instrument Control Workstations are sold by Affymetrix.

NOTE: Norton Antivirus can interfere with AGGC software. The symptom is that AGCC will stop generating CEL files. If that problem occurs, then you should check the Norton Anti-Virus settings as described in Appendix A, Settings for Norton Anti-Virus.

Installing AGCC with AGCC GeneTitan Control

Installing AGCC with AGCC GeneTitan Control requires the following AGCC components:

- AGCC Portal
- AGCC GeneTitan Control
- AGCC Viewer
- GeneTitan Library File Installer

NOTE: GeneTitan Library File Installer is installed with both AGCC and DEC.

AGCC with AGCC GeneTitan Control requires the following tools:

- Data Exchange Console
Chapter 2 | Installing AGCC 4.0 on Windows XP or Windows 7

- Reconnector
- GeneTitan Library File Installer

**NOTE:** GeneTitan Library File Installer is installed with both AGCC and DEC.

- Email Configuration Editor
- Data Uploader

The AGCC Instrument Control System requires the following:
- Installation on Windows XP Professional (32-bit) with SP3 or Windows 7 Professional (64-bit) with SP1.

**IMPORTANT:** A computer used as a GeneTitan workstation requires a user account with specific privilege settings. In addition, some of the other features of Windows XP or Windows 7 must be set up in particular ways or disabled to avoid causing problems when running GeneTitan IC software.

A workstation set up by Affymetrix for use with GeneTitan has a user account called AFFXUser with these privileges and features already set. If the settings have been changed, refer to Appendix A, Setup for GeneTitan IC Workstation on page 62 for information about the correct settings.

**NOTE:** Storage requirements depend upon how much data you wish to store on the Instrument Control system before moving the data to another computer.

- Systems equipped with Windows XP Professional (32-bit) with SP3 require Internet Explorer 8 (or higher) or Firefox 19 (or higher).
- Systems equipped with Windows 7 Professional (64-bit) with SP1 require Internet Explorer 10 (or higher) or Firefox 19 (or higher).

Instrument Control Workstations are sold by Affymetrix.

**Installing AGCC for Analysis Workstation**

AGCC without Instrument Control requires installing:
- AGCC Portal
- AGCC Viewer

The AGCC workstation (non-instrument control system) requires the following:
- Installation on Windows XP Professional (32-bit) with SP3 or Windows 7 Professional (64-bit) with SP1.
- 1 GB RAM (2 GB RAM Recommended)
- 500 MB free disk space for install
- 500 GB to 1 TB storage recommended

**NOTE:** Storage requirements depend upon the quantity of data being analyzed in a data set.

- Systems equipped with Windows XP Professional (32-bit) with SP3 require Internet Explorer 8 (or higher) or Firefox 19 (or higher).
- Systems equipped with Windows 7 Professional (64-bit) with SP1 require Internet Explorer 10 (or higher) or Firefox 19 (or higher).
- Dual 3.0 GHz Intel Processors (Dual-core or two dual processor systems recommended)
Installation and Configuration Outline

To install and configure AGCC:

1. Install the AGCC components.
   See *Installing the AGCC Components on Windows XP or Windows 7 on page 12* for more information.

2. Install the Affymetrix Data Exchange Console components (DEC).
   The Data Exchange Console install package installs:
   - Data Exchange Console (DEC)
   - Affymetrix Command Console Library Importer Tool
   - Affymetrix Command Console Reconnector
   - GeneTitan Library File Installer
   These tools enable you to:
   - Import or install Library files
   - Import data from GCOS systems
   - Reconnect broken data links
   These are necessary for installing library files and importing data from GCOS systems.
   See *Installing Affymetrix Data Exchange Console on page 19* for more information.

3. Install library files for the probe array types you are using.
   After installation, you need to install libraries for the probe array types you are using. See:
   - *Importing Libraries for Cartridge Arrays on page 31* for more information about cartridge array libraries.

4. Install Fluidics protocols.
   The fluidics protocols are files that list the steps used to process different types of probe arrays. You will need to install the protocols before using the AGCC Fluidics Control software. See *Installing Fluidics Protocols on page 47* for more information.

5. (Optional) Configuring AGCC software to use network functionality.
   A computer running AGCC can be connected to a Windows network to provide additional options for data organization and consolidation. To use network functionality, you need to configure AGCC Services.
   See *Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 of the AGCC User Manual* for more information.

6. (Optional) Add data roots and change default folders.
   The AGCC software uses data roots and a default folder to organize data. A default data root is created when AGCC is installed.
   Depending upon your situation, you may want to add additional data roots or change the default folder. For more information see:
   - *Adding the Network Data Storage as a Data Root* of the AGCC User Manual.
Managing Data Roots of the AGCC User Manual.
Specifying a Default Folder of the AGCC User Manual.

Installing the AGCC Components on Windows XP or Windows 7

**NOTE:** You must be logged in as a user with local administrative rights to install AGCC.

**NOTE:** The sample screen captures depicted in this guide may not exactly match the windows displayed on your monitor.

**NOTE:** The Command Console installer (depending on your system’s Operating System) installs either Microsoft .NET 4.0 or 4.5, then it installs Microsoft SQL Server 2005 Express Edition.

**NOTE:** Depending on other software already installed on your system, the screen shots throughout this document may vary (from what is on your screen).

At least 500 MB of available disk space is recommended for the installation.

To install AGCC software:

1. Unzip the AGCC install package by right-clicking on the install package and selecting Extract All.
2. Browse to the AGCCSetup folder in the unzipped install package.
3. Double-click on the AGCC_Setup_4.0.exe file.

   The self-extraction runs. (Figure 2.1)

When the self-extraction is complete, the AGCC InstallShield Wizard About window appears. (Figure 2.2)
4. Click **Install/**
   Allow several minutes for Microsoft .NET Framework to install. You may be prompted to restart your computer after .NET is installed.

**IMPORTANT:** If .NET 4.0/4.5 is not installed on your computer, the installer prompts you to install it. (Figure 2.4)
5. Click **Next**.
   The License Agreement window appears. (**Figure 2.5)**

6. After reading the License Agreement, select the button to accept the terms and click **Next**.
   The Instrument Selection window appears. (**Figure 2.6**)
7. Select the instrument control software you wish to install and click Next.

**IMPORTANT:** A computer used as a GeneTitan workstation requires a user account with specific privilege settings. In addition, some of the other features of Windows XP or Windows 7 must be set up in particular ways or disabled to avoid causing problems when running GeneTitan IC software.

A workstation set up by Affymetrix for use with GeneTitan has a user account called AFFXUser with these privileges and features already set. If the settings have been changed, refer to Appendix A, Setup for GeneTitan IC Workstation on page 62 for information about the correct settings.

The **Choose Destination Location** window appears. (Figure 2.7)
8. Accept the destination for AGCC and click **Next**.

   The following message appears. *(Figure 2.9)*

   ![Install DEC message](Figure 2.8)

9. Click **OK**.

   ![Install DEC message](Figure 2.9)

10. Click **OK**.

   The Installing Prerequisites window appears. *(Figure 2.10)*

   ![Installing Prerequisites window](Figure 2.10)

   After the prerequisites have been determined, the Setup Progress window displays the progress of the MSSQL install. *(Figure 2.11)*

   Allow several minutes for the MSSQL application to install.
When the MSSQL installation is finished, the Current Settings window appears. (Figure 2.12)

11. Click Next.
   The Setup Status window appears. (Figure 2.13)
12. Click **OK**.

The InstallShield Complete window appears. (Figure 2.15)

13. Click the **Yes, I want to restart my computer now** button, then click **Finish** to restart the computer and complete the installation.
After the computer restarts, you need to:

A. Install Affymetrix Data Exchange Console (DEC), which also installs the Library File Importer and the Reconnector.
   See Installing Affymetrix Data Exchange Console on page 19 for more information.

B. Install library files for the probe array types you are using.
   See:
   - Importing Libraries for Cartridge Arrays on page 31 for more information about cartridge array libraries.

C. Install Fluidics protocols.
   See Installing Fluidics Protocols on page 47.

NOTE: This step is not necessary if you are not installing the AGCC Instrument Control software.

You may also wish to:

- (Optional) Configure AGCC software to use network functionality.
  See Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 of the AGCC User Manual.

- (Optional) Add data roots and change default folders.
  For more information see:
  - Managing Data Roots of the AGCC User Manual.
  - Specifying a Default Folder of the AGCC User Manual.

Installing Affymetrix Data Exchange Console

The Affymetrix DEC installer installs:

- Affymetrix Data Exchange Console
- Command Console Library File Importer
- Affymetrix Command Console Reconnector
- GeneTitan Library File Installer

NOTE: GeneTitan Library File Installer is installed with both AGCC and DEC.

For more information, see the following documentation:

- Importing Libraries for Cartridge Arrays on page 31
- Installing GeneTitan Library Files on page 45
- Affymetrix® Data Exchange Console User’s Guide
- Affymetrix® Command Console® Reconnector User’s Guide

NOTE: You must be logged in as a user with local administrative rights to install the DEC software.

NOTE: The sample screen captures depicted in this manual may not exactly match the windows displayed on your monitor.
DEC is a separate application and does not require AGCC installation. You will need to install the library files for the probe array types you are working with to use DEC to import data, even if AGCC is not installed.

**IMPORTANT:** To use DEC to connect to a GCOS Server, you must install DEC for GCOS Server on the GCOS Server first. For more information, see *Installing DEC for GCOS Server on the GCOS Server on page 23.*

### Installing DEC and Other Components

To install DEC, Library Importer, and Reconnector:

1. Browse to the AGCCSetup folder in the unzipped install package.
2. Double-click on the `DEC_Setup_2.0.exe` file.

   The self-extraction runs. (Figure 2.16)

When the self-extraction is complete, the splash window appears. (Figure 2.17)

The DEC InstallShield Wizard Welcome window appears. (Figure 2.18)
3. Click **Next**.
   The **License Agreement** window appears. (Figure 2.19)

4. Read the license agreement, select the button to accept the terms, and click **Next**.
   The **Choose Destination Location** window appears. (Figure 2.20)
5. Accept the destination for DEC and click **Next**.
   The **Ready to Install** window appears. ([Figure 2.21](#))

6. Click **Install**.
   The Setup Status window appears. ([Figure 2.22](#))
When the install is finished, the InstallShield Complete window appears. (Figure 2.23)

7. Click **Finish** to complete the installation.

**Installing DEC for GCOS Server on the GCOS Server**

If you wish to connect to a GCOS server with DEC, you must install DEC for GCOS Server on the GCOS server. If DEC for GCOS Server is not installed on the server, you will see the following permission error (Figure 2.24):
To install DEC for GCOS Server:

1. If File Security is enabled on the GCOS Server, disable the File Security on the GCOS server before proceeding with the rest of the steps.
2. Browse to the AGCCSetup folder in the install package.
3. Double-click on the DECONGCOS_Server_Setup_1.0.exe file.
   If you have not disabled File Security on GCOS, the following error notice appears (Figure 2.25):
   - Click **OK** and disable the File Security on the GCOS Server and double-click on the DECONGCOS_Server_Setup_1.0.exe file.
   The DEC for GCOS Server InstallShield Wizard Welcome window appears (Figure 2.26):

4. Click **Next**.
   The Ready to Install window appears. (Figure 2.27)
5. Click **Install**.
   When the installation is finished, the Install Complete window appears. (Figure 2.28)

6. Click **Finish** to complete the installation.

<important>
**IMPORTANT:** When installing DecOnGcos on a computer running Windows Server 2003 and GCOS, you will need to set the DCOM configuration settings manually. See *Manually Configuring DCOM Permissions*, below, for more information.
</important>
Manually Configuring DCOM Permissions
When installing DecOnGcos on a computer running Windows Server 2003 and GCOS, you will need to set the DCOM configuration settings manually. This section explains how to set the DCOM configuration settings manually. See the GCOS Server Installation and Administration Guide for more information on the DCOM settings.

To manually configure DCOM permission:
1. Open a command window and type `dcomcnfg`.
   The Component Services snap-in appears. (Figure 2.29)
2. In the Console Root tree on the left side of the window, open Component Services → Computers → My Computer → DCOM Config.
3. Right-click on the AffyXMLFile Class node and select Properties. (Figure 2.30)
   The Properties window appears.
4. Click the Security tab. (Figure 2.31)
5. In the **Launch and Activation Permissions** section, select **Customize** and click **Edit**. The Launch Permission window appears. (Figure 2.32)

6. Edit the settings to give authenticated users launch permission. The permission may already be properly set.

**NOTE:** The **GcdoAffy** component permissions and the system **DCOM** permissions will already have been set by the **GCOS** server installer.

7. Click **OK** in the Launch Permission dialog box to close it.
8. In the Access Permissions section of the Security tab of the AffyXMLFile Class Properties window (Figure 2.33), select Customize, then click Edit.

![Figure 2.33 AffyXMLFile Class Properties dialog box, selecting Access Permissions](image)

The Access Permission window appears. (Figure 2.34)

![Figure 2.34 Setting Access Permissions for authenticated users](image)

9. Edit the settings to give authenticated users launch permission. The permission may already be properly set.

10. Click OK in the Launch Permission dialog box.

11. Click OK in the AffyXMLFile Class Properties window.

12. Close the Component Services window.
On Win2003, the system DCOM settings also need to be set on the system.

13. Click Start → Administrative Tools → Local Security Policy.

   The Local Security Settings window appears.

14. Select the Security Options under the Local Policy node in the tree on the left. (Figure 2.35)

   ![Figure 2.35 Local Security Settings window](image)

   There will be two DCOM: entries in the list on the right.

15. Double click the first DCOM item (Machine Access Restrictions in Security Descriptor Definition Language (SDDL) syntax).

   The DCOM: Machine Access Restrictions window appears. (Figure 2.36)

   ![Figure 2.36 DCOM: Machine Access Restrictions dialog box](image)

16. Click the Edit Security button.

   The Access Permission dialog box appears (Figure 2.37)
17. Add **Allow Local and Remote Access** permissions for **Authenticated Users**.

18. Click **OK** to close both dialog boxes.

19. In the Local Security Settings window, double click the second DCOM item (**DCOM: Machine Launch Restrictions in Security Descriptor Definition Language (SDDL) syntax**). The DCOM: Machine Launch Restrictions window appears. (Figure 2.38)

20. Click **Edit Security** button.

   The Launch Permission dialog box appears. (Figure 2.39)
21. Add **Allow Local and Remote Launch and Activation Permissions** for **Authenticated Users**.
22. Click **OK** to close both dialog boxes.
23. Close the Local Security Settings window.
24. Restart the computer.

**Importing Libraries for Cartridge Arrays**

The Affymetrix® Library File Importer imports GeneChip® Operating System (GCOS) library files into Affymetrix® GeneChip® Command Console™ (AGCC), either by reading library file information from a GCOS database, or by reading the information from a set of library installer files. It can be used along with the Data Exchange Console (DEC) to migrate your data from GCOS to AGCC.

The Importer allows you to:
- Import library file information from a GCOS database that is located on the same computer as DEC and Library File Importer.
- Import library file information from a GCOS server on a remote machine.
- Import library file information from library install files on CDs or other sources.

The Library File Importer is installed with the AGCC DEC installer. See *Installing Affymetrix Data Exchange Console on page 19* for more information on installing DEC and Library File Importer.

**NOTE:** GCOS can only be installed on a computer using the US English language operating system (OS). The Library File Importer can be installed on computers running operating systems with other languages, such as German OS. When the Importer is installed on a computer with a non–US English language OS, since there can be no GCOS database installed on the computer, the Import from Local GCOS Database option in the Library File Importer will not be available.
Starting the Library File Importer

To start the Library File Importer:

1. Click the Microsoft® Windows® Start button and select Programs → Affymetrix → Command Console Library File Importer; or

   Click the Library File Importer icon in the AGCC Launcher.

   The Welcome window appears. (Figure 2.40)

   ![Welcome window](image)

   The following navigation buttons are at the bottom of the window:

   - **License**: Display the license information.
   - **Cancel**: Close the dialog box.
   - **Next**: Go to the next step.

2. Select the type of source you wish to import from:
   - Import parameters from the GCOS database installed on the local workstation.
   - Import parameters from a GCOS server on another machine.
   - Import parameters from a GCOS library file package CD or folder.

3. Click **Next**.

4. The appropriate Select Source window appears for the type of source you selected:
   - Importing from Local GCOS Database, below
   - Importing from Remote GCOS Server on page 35
   - Importing from CD Files on page 38

Importing from Local GCOS Database

This option allows you to import library information into AGCC from a GCOS installation when AGCC and GCOS are installed on the same computer.

The Select Source window (Figure 2.41) appears when you have selected the Import from Local GCOS Database option.

You can use the **Back** button to return to the previous step.
To proceed with the import:

1. Select Save Location:
   Enter the path in the Select Save Location box; or
   A. Click **Browse**.
      The Browse for Folder window appears *(Figure 2.42)*
   
   B. Browse to the folder where you wish to place the library files; or
      Enter the name of the folder or the full Windows path for a folder.
   C. Click **OK**.

   **NOTE:** The default location for the AGCC library files is install drive letter:\command\console\library. AGCC will only use library files in the default location. Do NOT set the AGCC Library File location to the same location as the GCOS library file location as doing so will cause confusion.

2. Click **Next** in the Select Source dialog box.
The Select Probe Array Types window appears (Figure 2.43)

![Figure 2.43 Select Probe Array Types for import](image)

The Select Probe Array Types window displays a list of the probe array data available in the GCOS software.

3. Select files for import by clicking in the checkbox next to the file. You can also make and clear selections using the Select All and Unselect All buttons.

4. Click Start.
   If you have selected library files that are already installed, the Choose Library Version window appears (Figure 2.44)

![Figure 2.44 Choose Library Version window](image)

For information on choosing library versions, see Updating Library Versions on page 43. Otherwise, the Status window appears (Figure 2.45)
The Status window displays the progress of the library file import. Library files without part numbers are noted in the window.

- Click **Enter Part Numbers** to open the Enter Part Number dialog box (see *Providing Missing Part Numbers on page 44*).

When the import is complete, you can:

- Click **Import Others** to import additional library files.
- Click **View Log** to see information about the imports.
- Click **Finish** to close the window.

### Importing from Remote GCOS Server

This option allows you to import library files from a GCOS server on a remote machine.

**NOTE:** If you wish to import library files from a remote GCOS server, DTT 1.1 or later must be installed on the remote GCOS Server.
To proceed with the import:

1. Enter the name of the GCOS server in Select Source.
2. Select Save Location:
   Enter the path in the Select Save Location box; or
   A. Click Browse.
      The Browse for Folder window appears. (Figure 2.47)

   B. Browse to the folder where you wish to put the library files.
   C. Click OK.

   NOTE: The default location for the AGCC library files is install drive letter:\command_console\library. AGCC will only use library files in the default location.
3. Click **Next**.
   The Select Probe Array Types window appears (Figure 2.48)

![Figure 2.48 Select Probe Array Types](image)

The Select Probe Array Types window displays a list of the probe array data available in the GCOS software.

4. Select files for import by clicking in the checkbox next to the file.
   You can also make and clear selections using the **Select All** and **Unselect All** buttons.

5. Click **Start**.
   If you have selected library files that are already installed, the Choose Library Version window appears (Figure 2.49)

![Figure 2.49 Choose Library Version](image)
For information on choosing library versions, see *Updating Library Versions* on page 43. Otherwise, the Status window appears (Figure 2.50)

The Status window displays the progress of the library file import. Library files without part numbers are noted in the window.

- Click **Enter Part Numbers** to open the Enter Part Number dialog box (see *Providing Missing Part Numbers* on page 44).

When the import is complete, you can:

- Click **Import Others** to import additional library files.
- Click **View Log** to see information about the imports.
- Click **Finish** to close the window.

**Importing from CD Files**

This option allows you to install library files from the installation CD or other source, such as the Affymetrix.com website.

**To convert GCOS library files downloaded from NetAffx:**

2. Download the GCOS library files you wish to import into a folder on your computer.

**NOTE:** You do not need to unzip the library files after downloading, since the Library File Importer can import directly from the zip file.
To proceed with the import:

1. Select the file source (Figure 2.51):
   - Enter the path in the Select Source box; or
     A. Click Browse.
     - The Browse for Folder window appears (Figure 2.52)
     B. Select a folder for the file source.
     C. Click OK in the Browse for Folder dialog box.

2. Select Save Location:
   - Enter the path in the Select Save Location box; or
     A. Click Browse.
     - The Browse for Folder window appears (Figure 2.53)
B. Browse to the folder where you wish to place the library files.
C. Click **OK** in the Browser folder.

**NOTE:** The default location for the AGCC library files is install drive letter:\command\console\library. AGCC will only use library files in the default location.

3. Click **Next** in the Library File Importer window.
   The Select Probe Array Types window appears (**Figure 2.54**)

4. Select files for import by clicking in the checkbox.
   You can also make and clear selections using the **Select All** and **Unselect All** buttons.

5. Click **Start**.
   If you have selected the same library file from two sources, a warning box appears. (**Figure 2.55**)
Click **OK** to return to the Select Array window and deselect the duplicate array package.

For more information see *Choosing Between Library Files on page 42*.

If you have selected library files that are already installed, the Choose Library Version window appears (Figure 2.56)

For information on choosing library versions, see *Updating Library Versions on page 43*. Otherwise, the Status window appears (Figure 2.57)

Library files that do not have part numbers the status are noted in the window.

Click **Enter Part Numbers** to open the Enter Part Number dialog box (see *Providing Missing Part Numbers on page 44*).
When the import is complete, you can:
- Click **Import Others** to import additional library files.
- Click **View Log** to see information about the imports.
- Click **Finish** to close the window.

**Resolving Problems**

Three different types of problems may occur when importing library files:
- **Choosing Between Library Files**, below
- **Updating Library Versions on page 43**
- **Providing Missing Part Numbers on page 44**

**Choosing Between Library Files**

When performing an import from a library file package CD or folder, you may inadvertently select the same library from two different places. This may happen when you have a zipped and unzipped version of the same library files in the folder.

If you have selected the same library file from two sources, a warning box appears (Figure 2.58)

1. Click **OK** to return to the Select Array window and deselect the duplicate array package.
   
   The Select Probe Array Types window appears (Figure 2.59)

   ![Figure 2.58 Warning box](image)
   ![Figure 2.59 Select Probe Array Type window with the same library file selected twice](image)

   The Select Probe Array Types window displays a list of the library files available in the selected folder or CD with their location. Duplicate probe array files are grouped at the top of the list.

2. Deselect the duplicate files.

3. Click **Start** to continue with the import.
Updating Library Versions

In some cases, you may be trying to import a library that you already have installed on your computer. In this case, the Choose Library Version Window allows you to choose whether to install the new library or keep the old library.

If you have selected library files that are already installed, the Choose Library Version window appears (Figure 2.60)

This window displays the different versions of the installed files and the versions of the files selected for installation.

In some cases you can click on the Review Versions button next to the version information to open the Review Library File Versions dialog box (Figure 2.61).

The dialog box displays additional information about the conflict between the file versions.

To select the files for upgrading:

1. Select the file versions in the Choose Library Version window.
   
   You can:
   
   - Select files for update individually by clicking the radio buttons next to the file name
- Click **Keep All** to keep the installed file versions
- Click **Update All** to install the new versions for all files
- Click **Reset All** to automatically select the most recent version of each file.

2. Click **OK** to proceed.

3. The Status window appears, returning you to the import process.

**Providing Missing Part Numbers**

All newer chips with barcodes have array part numbers that identify their probe array types. A part number can be used by AGCC to automatically select:

- library files used in processing the array
- compatible fluidics protocols for processing the array
- scanner parameters for scanning the array.

Most libraries are assigned the same part number as the probe array for which they are used. Certain arrays can have two library sets. For example, some arrays may have probes for both SNP information and expression information. In these cases the user needs to select the appropriate library for the type of analysis being performed.

Earlier versions of GCOS software were not capable of dealing with two different part numbers assigned to the same array. In order to maintain compatibility with this earlier software, some of the library files for these probe arrays used with GCOS were not assigned part numbers. In order to import such library files into AGCC you will need to get a part number or use a default part number (99999999) for the library.

To obtain a part number from Affymetrix, please send an email message to Chip_Design@affymetrix.com with the subject line, "AGCC Part Number Request".

![Figure 2.62 Status window with missing part numbers](image)

To provide part numbers:

1. Click **Enter Part Number** in the Status window. (Figure 2.62).
   The Enter Part Number window appears (Figure 2.63).
The window displays the probe array types missing part numbers.

2. Enter the part numbers:
   A. Enter numbers if you have them available.
      The default part number (99999999) can be used if you do not have the actual part number.
   B. Click **Use Defaults for All** if you wish to use the default number for all the libraries.

3. Click **OK**.
   The Status window appears, returning you to the import process.

**Installing GeneTitan Library Files**

A separate tool is used to install GeneTitan Library files.

To install the GeneTitan library files:

1. In the AGCC Launcher, double-click the **HT Library File Installer** icon.
2. The GeneTitan Library File Installer appears. (Figure 2.64)

3. Select the source path for the library file package(s).
4. Use the default target path or select a new destination (not recommended).
   The available library file packages are displayed in the list (Figure 2.65).
5. Select the checkboxes next to the files you wish to install, or click the File Name checkbox to install all library files.

6. Click Install.
   The selected library files are installed (Figure 2.66).

When the install is complete, a notice box appears (Figure 2.67).

Click OK and close the GeneTitan Library File Installer.
Installing Fluidics Protocols

**NOTE:** This step is not necessary if you are not installing or using the AGCC Instrument Control software.

**NOTE:** For the GeneTitan Instrument, fluidics protocols are installed during the installation of the software.

To install protocols:

1. Click **Start** → **All Programs** → **Affymetrix** → **Command Console** → **Fluidics Script Installer**; or Double-click on the Fluidics Script Installer Icon in the Command Console Launcher; or
   A. Open the AGCC Fluidics Control software.
   B. From the Files menu in the Fluidics Control software, select **Install Protocols**...

   The Fluidics Scripts Installer appears (Figure 2.68)

2. Click **Next**.

   The Select Software window appears (Figure 2.69).
If you have both GCOS and AGCC installed, both radio buttons will be available.

3. Select the software you wish to install scripts for and click **Next**.

   The Select Source window appears (Figure 2.70).

   ![Figure 2.69 Select Software](image1)

   ![Figure 2.70 Select Source window](image2)

   The window enables you to:
   - Install the protocols from a directory on the file system.
   - Install the protocols from the Affymetrix.com web site.

   **NOTE:** Select this option only if you have a registered account with Affymetrix.com.

To install from a directory:

A. Select the option.

B. Enter the path to the directory; or
   - Click **Browse** and use the Select Directory dialog box to locate the directory with the scripts.

To install from Affymetrix.com:

A. Select the option.
B. Enter user name and password.

4. Click Next.

The Select Package window appears (Figure 2.71).

![Figure 2.71 Select Package window](image1)

The window displays a list of the fluidics scripts packages available from the selected source.

5. Select the package you wish to install and click Next.

The Select Protocols window appears (Figure 2.72).

![Figure 2.72 Select Protocols](image2)

The window displays a list of the protocols in the selected package with the following information:

- **Protocol Name**: With checkbox to select protocol for installation.
- **New Version**: Version of protocol in selected installation package.
- **Version of installed Script**: Version of protocol installed on your computer.

6. Select the checkboxes for the protocols you wish to install and click Next.

The Summary window appears (Figure 2.73).
The Summary window displays information about:

- Selected fluidics scripts
- Source Path
- AGCC Target Directory
- AGCC Log Path: location of the log file for this installation

7. Review the information and click **Next**.

   A progress bar displays the progress of the install (Figure 2.74).

When the install is completed, the Finish window appears (Figure 2.75).
8. Click **Close** to close the Installer.

9. If you opened the Installer through the AGCC Fluidics Control Software, you will need to close the software and reopen it for the installed scripts to appear in the drop-down lists.
Upgrading to AGCC 4.0 on Windows XP or Windows 7

IMPORTANT: AGCC 4.0 supports upgrades from AGCC 3.2.4 (or higher) on Windows XP and AGCC 3.3 (or higher) on Windows 7.

This chapter includes instructions for upgrading:
AGCC 3.2.4 (or higher) to AGCC 4.0 on a computer running Windows XP Professional (32-bit) SP3
AGCC 3.3 (or higher) to AGCC 4.0 on a computer running Windows 7 Professional (64-bit) SP1.
The upgrade process is described in the following sections:
- Upgrading the AGCC Components on Windows XP or Windows 7 on page 52
- Upgrading Affymetrix Data Exchange Console and Other Components on page 57

Upgrade Outline

To upgrade AGCC and DEC:
1. Upgrade the AGCC components.
   See Upgrading the AGCC Components on Windows XP or Windows 7 on page 52 for more information.
2. Install the Affymetrix Data Exchange Console components (DEC).
   The Data Exchange Console install package installs:
   - Data Exchange Console (DEC)
   - Affymetrix Command Console Library File Importer Tool
   - Affymetrix Command Console Reconnector
   - GeneTitan Library File Installer
   See Upgrading Affymetrix Data Exchange Console and Other Components on page 57 for more information.

Upgrading the AGCC Components on Windows XP or Windows 7

The AGCC installer can install the following components on a computer running Windows XP Professional (32-bit) SP3 or Windows 7 Professional (64-bit) SP1:
- Microsoft SQL Server Express 2005
- AGCC Portal
- AGCC Viewer
- Either:
  - AGCC Fluidics Control
  - AGCC Scan Control
- Or:
  - AGCC GeneTitan Control

NOTE: You must be logged in as a user with local administrative rights to install AGCC.

NOTE: The screen captures depicted in this guide may not exactly match the windows displayed on your screen.
At least 500 MB of available disk space is recommended for the installation.

To upgrade AGCC software:
1. Unzip the AGCC install package by right-clicking on the install package and selecting **Extract All**.
2. Browse to the AGCCSetup folder in the unzipped install package.
3. Double-click on the AGCC_Setup_4.0.exe file.
   The self-extraction runs (**Figure 3.1**).

   If a warning message about “Unknown Publisher” appears, click the **Run** button in the warning message to proceed with the install.

   The AGCC InstallShield Wizard Splash screen appears (**Figure 3.2**).

   An Upgrade Notice appears to inform you that a previous AGCC version is installed on your computer (**Figure 3.3**).
4. Click Yes to upgrade the software
   The AGCC Welcome window appears. *(Figure 3.4)*

![Figure 3.4 Welcome window](image)

5. Click Next.
   The License Agreement window appears. *(Figure 3.5)*

![Figure 3.5 License Agreement window](image)

6. After reading the License Agreement, select the button to accept the terms and click Next.
   The Instrument Selection window appears. *(Figure 3.6)*

"A different message may appear depending on the version of your software."
7. Select the instrument control software you wish to upgrade and click **Next**. The Review Install window appears. *(Figure 3.7)*

8. Review the installation options and click **Next**. The Setup Status window appears. *(Figure 3.8)*
When the install is finished, the DEC 2.0 upgrade notice appears. (Figure 3.9)

9. Click **OK**.
   The InstallShield Complete window appears. (Figure 3.10)

10. Click **Finish** to complete the install and restart the computer.
    After the computer restarts, you need to upgrade Affymetrix Data Exchange Console, which also upgrades the Library FileImporter and Installs the Affymetrix Reconnector.
See *Upgrading Affymetrix Data Exchange Console and Other Components* on page 57 for more information.

---

**NOTE:** After upgrading to AGCC 4.0, network data roots need to be re-configured with appropriate permissions. Refer to the "How to configure network data storage" tutorial at www.affymetrix.com for more information.

---

### Upgrading Affymetrix Data Exchange Console and Other Components

The Affymetrix DEC installer upgrades:

- Affymetrix Data Exchange Console
- Command Console Library File Importer
- Affymetrix Command Console Reconnector
- GeneTitan Library File Installer

For more information, see the following documentation:

- *Importing Libraries for Cartridge Arrays* on page 31
- *Installing GeneTitan Library Files* on page 45
- *Affymetrix® Data Exchange Console User’s Guide*
- *Affymetrix® Command Console® Reconnector User’s Guide*

---

**NOTE:** You must be logged in as a user with local administrative rights to install the DEC software.

---

**NOTE:** The screen captures depicted in this manual may not exactly match the windows displayed on your screen.

---

DEC is a separate application and does not require AGCC installation. You will need to install the library files for the probe array types you are working with to use DEC to import data, even if AGCC is not installed.

---

**IMPORTANT:** To use DEC to connect to a GCOS Server, you must install DEC for GCOS Server on the GCOS Server first. For more information, see *Installing DEC for GCOS Server on the GCOS Server* on page 23.

---

### Updating DEC and Other Components

To update DEC, Library Importer, and Reconnector:

1. Browse to the AGCCSetup folder in the unzipped install package.
2. Double-click on the DEC_Setup_2.0.exe file.

The self-extraction runs (Figure 3.11).
An Upgrade Notice appears to inform you that DEC 1.0 or 1.1 is already installed on your computer (Figure 3.12).

3. Click Yes to proceed.

The DEC Installation Splash Screen appears (Figure 3.13).

The DEC InstallShield Wizard Welcome window appears. (Figure 3.14)
4. Click Next. The License Agreement window appears. (Figure 3.15)

5. Read the license agreement, select the button to accept the terms, and click Next. The Choose Destination Location window appears. (Figure 3.16)
6. Accept the destination for DEC and click **Next**. The **Ready to Install** window appears. *(Figure 3.17)*

7. Click **Install**. The Setup Status window appears. *(Figure 3.18)*
When the install is finished, the InstallShield Complete window appears. (Figure 3.19)

8. Click **Finish** to complete the installation.
Setup for GeneTitan IC Workstation

When Affymetrix sets up a computer for use as a GeneTitan workstation, the computer is configured with a user called **AFFXUser**. The user account has certain privileges that are required for the operation of GeneTitan IC.

In addition, some of the other features of Windows XP or Windows 7 need to be set up in particular ways or disabled to avoid causing problems when running GeneTitan IC. These include things like the power control features, the auto update feature, and the Daylight Savings Time Adjustment.

This appendix describes the settings that must be made to restore a GeneTitan workstation to its standard configuration.

**To set up power mode:**

1. Right click on a blank area of the desktop and select **Properties**.
   The Display Properties dialog box appears.

2. Select the **Screen Saver** tab.
   A. Select None from the **Screen saver** drop down box.
   B. Click **Apply**.

3. Click the **Power**... button in the Screen Saver tab.
   The **Power Options Properties** dialog box appears.

4. Select the **Power Schemes** tab.
   A. Select **Always On** from the **Power schemes** drop down box
   B. Click **Apply**.
   C. Select **Never** from the **Turn off monitor:** drop down box.
   D. Click **Apply**.

5. Select the **Hibernate** tab.
   A. Remove the check from **Enable hibernation**.
   B. Click **Apply**.
   C. **Click OK in the Power Options Properties dialog box**.

6. Click **OK** in the **Screen Saver** tab of the **Display Properties** dialog box.

7. Close all open windows.

**Taskbar and Start Menu set up**

1. Enable classic start menu:
   A. Right click on a blank area on the taskbar and select **Properties**.
      The Taskbar and Start Menu Properties dialog box appears.
   B. Select the **Start Menu** tab.
   C. Select the **Classic Start menu** radio button.
   D. Click **Apply** in the **Taskbar and Start Menu Properties** dialog box.
   E. Click **OK** in the **Taskbar and Start Menu Properties** dialog box.

2. Enable Administrative Tools and start menu settings:
   A. Right click on a blank area on the taskbar and select **Properties**.
   B. Select the **Start Menu** tab.
   C. Click the **Customize...** button.
      The **Customize Classic Start Menu** dialog box appears.
D. In the Advanced Start menu options: list box, check the following:
   - Display Administrative Tools
   - Display Run
   - Enable dragging and dropping
E. Ensure all other items are unchecked. Be sure to scroll down in the list box.
F. Click OK in the Customize Classic Start Menu dialog box.
G. Click OK in the Taskbar and Start Menu Properties dialog box.

3. Disable Auto Update:
   A. Go to Start → Programs → Administrative Tools → Services.
      The Services window appears.
   B. In the Services list, right click Automatic Updates and select Properties from the context-sensitive menu.
      The Automatic Updates Properties dialog box appears.
   C. Select Disabled from the Startup Type dropdown list.
   D. Click Apply.
   E. Click Stop under Service status.
   F. Click OK in the Automatic Updates Properties dialog box.
   G. Close the Services window.

Change Security settings
1. Go to Start → Settings → Control Panel.
   The Control Panel appears.
2. Double-click the Security Center icon.
   The Windows Security Center window appears.
3. In the Windows Security Center window, select Change the way Security Center alerts me.
4. Remove checks from all boxes listed and select OK.

Configure User
1. In the Control Panel window, double-click User Accounts icon.
   The User Accounts window appears.
2. Click User Accounts on the next window.
3. Click Change the way users log on or off.
4. Uncheck Use the Welcome screen. The other box will automatically become unchecked. Click Apply options.
5. Click AFFXUser.
6. Verify that the password for this user has been created. If not, create one by clicking "create a password" and enter a password twice then click the "create password" button. Click "Yes, make private" if prompted.
7. Close all open windows.

NOTE: This account type stays as Administrator.

8. Go to Start → Programs → Administrative Tools → Local Security Policy.
9. In the left pane, double click Local Policies and select User Rights Assignment.
10. Double click on Log on as a batch job.
11. In the pop up window click **Add User or Group**.
12. Verify that the workstation name is selected under **From this location**.
13. In the **Enter the object names to select** box type Administrator;AFFXUser.

**NOTE:** Do not type in Administrators, as this will give rights to the entire group.

14. Click **OK**. Verify that the two users have been added to the list. Click **OK** again.
15. Double click on **Log on as a service**.
16. In the pop up window click **Add User or Group**.
17. Verify that the workstation name is selected under **From this location**.
18. In the **Enter the object names to select** box type Administrator;AFFXUser.
19. Click **OK**. Verify that the two users have been added to the list. Click **OK** again.
20. Close all open windows.

**Configuring the Network**

1. Navigate to **Start** → **Settings** → **Control Panel**
   The **Control Panel** window appears.
2. Double-click the **Network Connections** Icon.
   The **Network Connections** window appears.
3. Right click the **Local Area Connection** icon and select **Properties**.
   The **Local Area Connection Properties** dialog box appears.
4. Check **Show icon in notification area when connected**.
5. Click **OK**.
   The **Local Area Connection Properties** dialog box closes.
6. In the **Network Connections** dialog box, right-click **Local Area Connection** and select **Properties**.
7. Click **Configure**.
   The **Properties** dialog box for the selected connection appears.
8. Select the **Power Management** tab.
9. Ensure both boxes in the tab are unchecked then click **OK**.

**Configuring the Date and Time Properties**

1. Navigate to **Start** → **Settings** → **Control Panel**.
   The **Control Panel** window appears.
2. Double-click the **Date and Time** Icon.
   The **Date and Time Properties** dialog box appears.
3. Select the **Time Zone** Tab.
4. Ensure **Automatically adjust clock for daylight saving changes** is unchecked.
5. Click **OK** in the Date and Time Properties dialog box.

**Set Folder Options**

1. Select the **My Computer** icon on the desktop.
   The **My Computer** window appears.
2. Open the **Tools** menu and then select **Folder Options**.
   The **Folder Options** dialog box appears.
3. Click on the **View** tab.
4. In the **Advanced settings**: list box, make certain that **Hide extensions for known file types** is unchecked.

5. Click **OK** in the Folder Options dialog box.

**Empty Recycle Bin**

1. Close any pop-up windows.
2. Delete any "arrowed" shortcuts (except for the Affymetrix Launcher).
3. Right-click on the **Recycle Bin** icon on the desktop and select **Empty Recycle Bin**.
4. Answer **Yes** when in the Confirm dialog box.

**Clearing the Event Viewer**

1. Login as **AFFXUser** with password.
2. Close all windows.
3. Go to **Start → Settings → Control Panel**.
   
   The **Control Panel** window appears.
4. Double-click the **Administrative Tools** icon.
   
   The **Administrative Tools** window appears.
5. Double-click the **Event Viewer** icon.
   
   The **Event Viewer** window appears.
6. Highlight **System** in the pane on the left side of the window.
7. From the **Actions** menu, select **Clear All Events**. Do not save the log before clearing it.
8. Highlight **Security** in the pane on the left side of the window.
9. From the **Actions** menu, select **Clear All Events**. Do not save the log before clearing it.
10. Highlight **Application** in the pane on the left side of the window.
11. From the **Actions** menu, select **Clear All Events**. Do not save the log before clearing it.
12. Close **Event Viewer**.
13. Empty the **Recycle Bin**.